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Once the files have been loaded to the computer, EFB can be started from
Start Menu > All Programs > FDOT.EFB 3.2 > FDOT EFB Desktop 3.2 or
from the desktop icon or by click on the FDOT EFB Desktop 3.2 icon
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Once the files have been loaded to the computer, EFB can be started from Start
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This is the EFB 3 desktop as it first opens.

The desktop has all the same functionality as the data collector program plus a few
others that will be covered.

Just like Data Collector version you have to create or open a SDF file before you can
start using the desktop.

The SDF file has replaced the RAW file. The reason for the new SDF file is because is
based on a sequel database format.

And they could not crack the code for the RAW file.
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Most of the time you will be opening an .SDF file that you have copied from the data
collector. The Data and CTL tabs are grayed out if you click on one of them you....
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will get this message and you will have to open a segment SDF file before you can
continue.
You can either open a .SDF file from...
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the File tab and selecting the Open button or...
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from the File option in the Menu bar. Once you have made you choice...
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The open SDF File window will open, navigate to where you have the SDF file stored
and select it.
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The segment file name will be shown in Header of the desktop and the Data and CLT
tabs are now available to be selected.

Also you will notice that there is information showing up in the Tree View.

From here....
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you can select the CTL Tab.
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If you need to create or edit an existing control file for processing. This is the basically

Rays CTL program with user friendly interface.
To create a new CTL file, The Control File Header must be completed first. This can be

done by selecting the...
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Selecting Control Points Setting under Control Points in the Menu Bar...
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the Control File Header will have to be completely filled out before you can to begin
adding the control points.
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Once you have filled out the information make sure the cursor in in the message field
and press “0” (Zero button) to store then hit Enter to go back to the main CTL tab.
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To add a control point you can select the...
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Select “Add Point” from the Control Point from the Bar menu...
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This will open the Control Point window. As you select the fields to fill in keep an eye

on the message field, it will tell you what information goes in the box you are in. The
2nd columns of boxes after the X,Y, and E...
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are for the error estimates. After you have added all the point data make sure that
the cursor is in the message field and press 0 to store the point data. You will need to
store after each control point you enter. If you need to delete a control point from the
CTL file this can be done by either entering...
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the point name in the name field and pressing the 3 key...
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If you need to edit a control point either key in the point name in the name field or
select the control point from the Tree view under Points...
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make any corrections and then ensure that the cursor is in the message field and
press zero to store. After you have completed creating or editing the segment control
file make sure the cursor is in message filed and press the enter key to go back to the
CTL main tab...
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Data tab to open the data window or EFB.
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The Data tab will allow you to review the field data and perform the same field edits
that you just as you would in the field on a data collector. This was not designed to be
a full editor any major edits are still going to be made in the OBS.
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After you have made any field edits you are ready to begin processing the field data
you must first export an OBS file by going to File Export Observations and Chains as
OBS. Make sure that you are storing the OBS file in the correct segment directory. The
OBS file can be reviewed from the New Segment File Analysis tool.
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The Segment Files Analysis tool box opens when “EFB Processor (EFB)” is selected
from the File Menu bar.
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The Segment Files Analysis tool box runs EFBP to make it a little more user friendly. It
is still running Dr. Hintz’s EFBP programs in the background so the same reports that
you are used to seeing are still getting created.
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Selecting the Browse... button will open the...
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The Browse Segment File Reports box which lets you open files to review and edit by
either checking the box or boxes next to the files you want to review and then
selecting Open or just you can open them one at a time by double clicking on the file
name. This will open files in Notepad. After you close the Reports box...
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Focus is brought back to the Segment Files Analysis box. To change or review the
Error Estimates before processing select the...
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Error Estimates tab.
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Distance PPM |5.00
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Correct for curvature and refraction
Prompt for robustness

Save Segment Defaults
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[ Process Survey Data ] [ EFBP Handbook I
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2012
PPesign Training
Expo

The estimates are read from the EFB_Setting.xm| when EFB Processor is opened and
the DEFAULT.SD and DEFAULT.CON will be created in the segment directory. If the
settings for the DEFAULT.SD and DEFAULT.CON files are already existing for the
segment data you are going to process they could placed in the segment folder
before opening the EFPB Processor (EFBP) and the Segment Analysis tool will use
them instead of the ones in the EFB_Setting.xml file.

38



E3 Segment Files Analysis E\ E\
C:\e\Projects\1234567\A
UseRepetition @ Yes O No
Horizontal Distance [0.010 |
Distance PPM (500 |

Horz. Angle 40 \

Azimuth (seconds) |0.1 |

Tiig Leveing [0.020 |

Tiig Leveling PPM (2000 |
Differertial Leveling [0.010 |
Setup Error 1070157

Dutput post-analysis std. errors [
Correct for curvature and refraction
Prompt for robustness

Save Segment Defaults

[ select Project Folder | [ FBP TechricalRet |

[ Process SuveyData | [ EFBP Handbook |

EdtCotol | Cose |

2012

»Esl'gn Training
EXpo

The Edit Control button kicks off the old DOS CTL program so if you are more
comfortable that instead of the CTL tab it is still available.
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The Select Project Folder button lets you quickly change from one segment to
another if you have multiple segment to process.
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The Process Survey Data button runs EFBP. But before EFBP is run there are a few
options back in the Processing Options Tab that you may want to look at.
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Here you can select which report you want EFBP to Stop processing at, the default is
Final Coordinates so you can review the .SUM file from the Browse button for all
flagged issues.
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Once you are ready to process click on the Process Survey Data button, after EFBP has
run...
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The View Report buttons in the Processing Options tab should be available, or you
can view reports from the ...
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E3 Segment Files Analysis E\ E\

C:\e\Projects\1234567\A

Processing Options | Enor Estimates

© Preliminary Analysis
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Horizontal Distances |0.030 |
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|4 v
: Manuscript..

[ select Project Folder | [ FBP TechricalRet |

[ Process SuveyData | [ EFBP Handbook |

[ edcowo  |[ coe |

i

the Browse Button and select which report you want to review. If you are

reprocessing a segment you will get a message...
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Reports Exists!

': Reports for project 12345674 already exist in the current folder: C:\e\Projects|1234567\A
Do you want to overwrite the existing report files?

[ ves JL _mo J[ conce ]

2012

»Esl'gn Training
EXpo

to let you know reports already exist to make sure don’t unintentionally override
them.
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E3 Segment Files Analysis E\ E\
C:\e\Projects\1234567\4
Processing Options | Enor Estimates

O Prelinay Andysi
© Vettical Least Squares
O Horizontal Least Squares
@® Final Coordinates

r Tolerance Exceptions in Reports

Horizontal Distances :ﬂ030 |
Horzontal Angles (seconds) (200 |
Elevation Dilferences [0.100 |

r Output Coordinate Precision —
Browse...

[4 v/
= Manuscript..

[ select Project Folder | [ FBP TechricalRet |

Process Survey Data EFBP Handbook

[ Edcowo ][ cise

/

Once you have finished processing close the Segment Files Analysis box.
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[Comoobs [ @search ]
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To take you back to the EFB Desktop so you can begin to create the export files.



2012

»esign Training
; EXpo

&3 EFB Desktop 3.2 - 1234567A.sdf

Fle Edt ControlPonts Help

Field View - 1234567A.sdf

©0ata [(Q)cTL | (F) Fie|
[ reader ] [_e)sor-obs |
(2) Calibration (7) Remarks
(3) Test (8) Chains.
(4) Setup (9) Taping
[Comoobs [ @search ]

MSG> w’ ”tF’m

—{&) Control Point GPSS
—{3) Control Point GPS6
&) Control Point Al
{5y Control Point A2
—( Control Point A3
@ Control Point A4
—{&) Control Point AS
{5} Control Point A6
{5 Control Point A21

L ) Control Point A21

You will notice that the Points listed in the Tree View show the segment control

points...
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New
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#

L3

=) Import » 0BS - Observations & Chains
[Z Merge » J CTL - Control Points
(& Export » XVZ - Points
Seed New Segment & Landxm
Use CEFB Input Mode Validate LandXML 1.2 Fie
Generate Poling Log [Search |

EFB Processor (EFBP)
'SDMS Processor

- Points
{5 Control Point GPSS
—{5) Control Point GPS6
{5} Control Point Al
&) Control Point A2
(&) Control Point A3
(&) Control Point A4
@ Control Point AS
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The final segment XYZ file will have to be imported into the segment SDF file to
create the segment LandXML file. This file can read into MicroStation/Geopak and
Civil 3D.The segment XML file is also used to create files to be read into CAICE and
GEOPAK. You may want to make sure that you have a clean back-up copy of all your
SDF files before importing since the segment points will be written to the SDF file.
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The imported points from the XYZ file are also labeled as control point, this was a
condition with creating the LandXML file so the points could be exported from the
SDF file.
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To export the segment LandXML file go to File \ Export \ LandXML...



Save As XML...

Savein: | ) A v/ Qi@

My Recent
Documents

€

Desktop

My Documents

My Computer

File name: 12345674 v

i

My Network T 7
Places | Saveastype: [XMLFies ("xm) v
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The default is the segment name if you wish to change it you may.
This is file that can be imported into MicroStation/Geopak or into Civil 3D.

If you want to bring this data into CAICE then the XML file will need to be
“Converted”...
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The Conversion utility is opened from File \ Export \ Convert EFB LandXML to SRV,
KCP, INP...



158 LandXML to CAIiCE / GEOPAK Conversion 1.1.4447 Copyright © FDOT 2009-2011

LandML Input | CAICE SRV Output | CAICE KCP Output | GEOPAK INP Dutput | Land<ML Grouped Dutput | Conversion Log | About |
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One the Conversion Utility opens select the “Input XML” button...
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Open XML Input Data EJ@

:: N Aa e
My Documents
My Computer
File name: 112345674 5l v | oOpen |
My Network - )
YPlaces | Flesoftype: | XML Fies v Cancel | |
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and select the segment XML file to should default to the segment folder.



dXML to CAICE / GEOPAK Conversion 1.1.4447 Copyright © FDOT 2009-2011 =

Input XML {E\E\P'oi:as\Nm Folder\1234567\A\12345674 xml "
) Points/Chains

|C:\e\Projects\New Folder\1234567\A\1 21567 stv =
DefahZ: 939993900 |
|C\e\Projects\New Folder\1 234567\A\1 245674 kep (]
|C\etProlectstNew Folder\1 234567AN1 2345674 inp =
| C\etProjects\New Folder\1 234567\AN1 2345674_Grouped aml =
hower

Land<ML Input | CAICE SRV Output | CAICE KCP Dutput | GEOPAK INF Output | LandXML Grouped Dutput | Conversion Log | About

Ready

2002
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After the segment XML file is read you will need to decide what files and data you
want included in the out put files. If you are going to be working in CAICE it is
recommended that you export a KCP with Chain only. Then import the final XYZ in to
the CAICE segment and then read the KCP file in to the CAICE database. If you export
points with the KCP file CAiCE will renumber the points without letting you know until

itis to late.
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58 LandXML to CAIiCE / GEOPAK Conversion 1.1.4447 Copyright © FDOT 2009-2011

C\e\Projects\New Folder\1 2345677A\ 1 2348674 arl ] Etp
|

|C:\e\Projects\New Folder\1234567\A\1 21567 stv (L OO
DefaulZ: | -33339.3900 ]
|C\e\Projects\New Folder\1 234567\A\1 245674 kep 2 O
|C:\e\Proijects\New Folder\1 2345674441 2345674 inp =
Output XML | C:\eAPuojects\Mew Folder\1 234567\A\1234567A_Grouped sl =
[[] Ordes By:

Land<ML Input | CAICE SRV Output | CAICE KCP Output | GEOPAK INP Output | LandXML Grouped Dutput | Corgsi

CiielProjectsiNew Folderl12345671A11234567A, xml
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After you have made your choice of what files to create and what to add to them
press the Process/Convert button.
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58 LandXML to CAICE / GEOPAK Conversion 1.1.4447

Input XML ‘AC:\e\onieds\New Folder\1234567\A\1234567A xml

Output SRY [C:\e\onied:\Now Folder\1234567\A\1234567A.s1v

) OO
[] DefauZ: 939939300 |
[DutputKCP ] [C:e\Projects\New Folder\1234567\8\1234567A kep ™ &
Ouput INP | [C:\e\Projects\New Folder\1234567\A\1234567A.inp =
[C:\e\Projects\New Folde\1 23456 7\AN1 2345674_Grouped xml I
(] Order By: Process/Convert

LandiML Input | CAICE SRV Output | CAICE KCP Output | GEOPAK INP Dutput | LandXML Grouped Output | Conversion Log | About |

~
<?xml version="1.0" ?>
- <LandXML xmins="http://www.landxml.org/schema/LandXML-1.2"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http:/ /www.landxml.org/sch /Land -1.2 ../LandXML-
1.2.xsd" date="2012-03-29" time="11:21:49" version="1.2" language="English"
readOnly="false">
- <Units>
<Imperial areaUnit="squareMiles" linearUnit="USSurveyFoot"
volumeUnit="US_gallon" temperatureUnit="fahrenheit" pressureUnit="inchHG"
angularUnit="decimal dd.mm.ss" latLongAngularUnit="decimal dd.mm.ss"
elevationUnit="feet" />
</Units>
<CoordinateSystem name="NADS83 Florida State Plane Zone 0903, US Survey Foot”"
horizontalDatum="NAD83" verticalDatum="NAVD88" ellipsoidName="WGS84" 3

Finished Processing.

After the files have been created review the Conversion Log Tab to see if there were

any issues.
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andXML to CAIiCE / GEOPAK Conversion 1.1.4447 Copyright © FDOT 2009-2011

Input XML |[C:\e\Projects\New Folder\1234567\A\12345674 xmi

e | N

Output SRY | C:\e\Projects\New Folder\1234567\A\1234567A stv
[V] DefautZ:  |-33393.9300

Output KCP [C:\e\onisds\New Folder\1234567\A\1234567A kcp

Ouput INP | [C:\e\Projects\New Folder\1234567\A\1234567A.inp

Output XML {C:\e\ﬁoiads\New Folder\1234567\A\12345674_Grouped.xml
(] Order By - Process/Convert

000 O

| Land<ML Input | CAICE SRV Output | CAICE KCP Output | GEOPAK INP Output | LandXML Grouped Dupu: Conversion Log ‘Abo\x
ww* §/26/2012 4:46:22 PM Begin processing *** EFBLandXMLCvt 1.1.4447 Copyright A®©
Begin reading input file - C:\e\Projects\New Folder\1234567\A\1234567A.xml
Converting to CAiCE KCP - C:\e\Projects\New Folder\1234567\A\1234567A.kcp
Converting to GEOPAK - C:\e\Projects\New Folder\1234567\A\1234567A.inp

*** 4/26/2012 4:46:24 PM End processing "**

<

C:lelProjectsiNew Folder\12345671A11234567A _log.txt

From here you can close the Conversion Utility and the EFB Desktop and move on to

your CADD program.
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Bret Brunow, P.S.M.

Florida Department of Transportation
Central Office Surveying and Mapping
Tallahassee
bret.brunow@dot.state.fl.us
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